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Disclaimer

1.1 AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses.

AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any special,
indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered by the
user, including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created by the
AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, tort
(including negligence) or otherwise.

1.2

1.3 AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the
performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's
claim is brought.

1.4 Clauses 1.1 to 1.3 shall apply to the fullest extent permissible at law.

In the event of any conflict between the above clauses and the analogous clauses in the software licence under
which the AVEVA software was purchased, the clauses in the software licence shall take precedence.

1.5

Copyright

Copyright and all other intellectual property rights in this manual and the associated software, and every part of it
(including source code, object code, any data contained in it, the manual and any other documentation supplied
with it) belongs to, or is validly licensed by, AVEVA Solutions Limited or its subsidiaries.

All rights are reserved to AVEVA Solutions Limited and its subsidiaries. The information contained in this document is
commercially sensitive, and shall not be copied, reproduced, stored in a retrieval system, or transmitted without the
prior written permission of AVEVA Solutions Limited. Where such permission is granted, it expressly requires that
this copyright notice, and the above disclaimer, is prominently displayed at the beginning of every copy that is made.

The manual and associated documentation may not be adapted, reproduced, or copied, in any material or electronic
form, without the prior written permission of AVEVA Solutions Limited. The user may not reverse engineer,
decompile, copy, or adapt the software. Neither the whole, nor part of the software described in this publication
may be incorporated into any third-party software, product, machine, or system without the prior written
permission of AVEVA Solutions Limited, save as permitted by law. Any such unauthorised action is strictly prohibited,
and may give rise to civil liabilities and criminal prosecution.

The AVEVA software described in this guide is to be installed and operated strictly in accordance with the terms and
conditions of the respective software licences, and in accordance with the relevant User Documentation.
Unauthorised or unlicensed use of the software is strictly prohibited.

Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved. AVEVA shall not be
liable for any breach or infringement of a third party's intellectual property rights where such breach results from a
user's modification of the AVEVA software or associated documentation.

AVEVA Solutions Limited, High Cross, Madingley Road, Cambridge, CB3 0HB, United Kingdom.

Trademarks

AVEVA and Tribon are registered trademarks of AVEVA Solutions Limited or its subsidiaries.  Unauthorised use of the
AVEVA or Tribon trademarks is strictly forbidden.

AVEVA product/software names are trademarks or registered trademarks of AVEVA Solutions Limited or its
subsidiaries, registered in the UK, Europe and other countries (worldwide).

The copyright, trademark rights, or other intellectual property rights in any other product or software, its name or
logo belongs to its respective owner.
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CHAPTER 1 - Preface

LFM NetView Project Publishing Guide

Preface1

This chapter gives basic information about this guide, training and support.

About this Guide1.1

This guide describes how to publish a project to AVEVA LFM NetView.

Audience1.2

This set of documentation is aimed at new users and covers the use of AVEVA

LFM Server: Server Mode, its associated CAD links and the production of AVEVA

LFM related resources such as HyperBubble data, Solid Point Cloud data and

AVEVA LFM NetView projects. The contents cover operations for both

Engineering Users and Project Administrators. It is assumed that the user already

has AVEVA LFM Server installed and has the appropriate license features

available.
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Related Documents1.3

Other related documents include:

· AVEVA LFM Server - Autodesk AutoCAD Interface

Also covers AutoCAD MEP, CADWorx and Bentley AutoPLANT

· AVEVA LFM Server – Autodesk Navisworks Interface

· AVEVA LFM Server – Autodesk Revit Interface

· AVEVA LFM Server - Aveva PDMS CAD Interface

· AVEVA LFM Server - Aveva Review CAD Interface

· AVEVA LFM Server - Bentley MicroStation CAD Interface

Also covers Bentley ConstructSim

· AVEVA LFM Server - Intergraph PDS CAD Interface

· AVEVA LFM Server - Intergraph SmartPlant 3D CAD Interface

· AVEVA LFM Server - Intergraph SmartPlant Review CAD Interface

· AVEVA LFM Server - COMOS Walkinside CAD Interface

· AVEVA LFM Server - Quick Start Guide

The AVEVA LFM Server Quick Start Guide is not intended to cover every

aspect of this package, but should provide designers with a 3D CAD

background a quick introduction to common features and typical project

requirements.

· AVEVA LFM NetView Project Publishing Guide

This guide covers the creation and deployment of an AVEVA LFM NetView

project from the point that the AVEVA LFM Server dataset (.lfd) is

available up until, and including the point where the VHD is created.

· AVEVA HyperBubble and Solid Point Cloud Creation and Use Guide

This guide covers everything related to the new HyperBubble feature

including pre-requisites, publishing and use.

Note: These documents can be accessed by opening the file browser and

browsing to the location where AVEVA LFM Server is installed. By default, they

are available at the following location:

C:\Program Files\LFM Software\LFM\helpfiles
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Technical Support1.4

Online support and more information about AVEVA LFM should be requested

through lfm.support@aveva.com

To aid fault diagnosis, please include the following information when contacting

AVEVA LFM Support:

· Urgency

· Full version number of AVEVA LFM Server

· Information about any CAD package being connected to (including full

version number)

· AVEVA LFM Server log files. To obtain these, go to the File > Home tab

and click the Copy Log Files button. This copies a series of 5 text files to

the location of your choice. These will be called lfmServerRunA.log –

lfmServerRunE.log. Please send all 5 files.

AVEVA LFM Upgrades

Upgrades can be downloaded from the AVEVA LFM Software website from

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM

-Support.

Product and Training Information1.5

For general information and commercial enquiries, please contact

lfm.info@aveva.com.

For information about product training courses, see the Product Training section of

AVEVA's website (http://www.aveva.com/training), or contact the nearest AVEVA

Regional Support Centre (http://support.aveva.com/support).

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
http://www.aveva.com/training
http://support.aveva.com/support


Page 8 Release 5.3

© Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.

 

CHAPTER 2 - Overview

LFM NetView Project Publishing Guide

Overview2

AVEVA LFM NetView project creation is a one-off operation which is performed in

AVEVA LFM Server: Server Mode. AVEVA LFM NetView project creation is a

completely lossless process in which none of the data from the original scans is

lost.

There are three different ways of hosting an AVEVA LFM NetView project. These

are:

· Hosted on AVEVA LFM Software’s cloud account (hosting fee applies)

· Hosted on your own cloud account

· Hosted on an in-house server

This document covers the hosting process, starting from the point where the

AVEVA LFM Server dataset (.lfd) is available, up to and including the point of

Virtual Hard Drive (VHD) creation. After this point, an AVEVA LFM Value Added

Reseller (VAR) will provide further guidance on a one-to-one basis. To find your

local AVEVA LFM VAR, please visit http://web.lfm-software.com/en/Value-Added-

Resellers.aspx. If there is no AVEVA LFM VAR in your area, please contact

lfm.support@aveva.com.

http://web.lfm-software.com/en/Value-Added-Resellers.aspx
http://web.lfm-software.com/en/Value-Added-Resellers.aspx
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The AVEVA LFM NetView project deployment process can be seen in the

workflow below:
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Prerequisites3

The pre-requisites cover the following requirements:

· Graphical Requirements 

· Advanced Mode Installation 

· License Requirements 

Graphical Requirements3.1

AVEVA LFM NetView project publishing requires a reasonably powerful graphics

card with the very latest drivers. It has been developed using NVidia graphics

cards, and AVEVA LFM recommends using these where possible for optimum

performance and reliability. AVEVA LFM have also tested with a selection of

alternate cards which are detailed below.

Do not rely on Windows graphics driver properties to update to the latest version,

instead use the NVidia tools. Visit http://www.nvidia.com/download/scan.aspx?

lang=en-us to obtain the latest version.

The supported OpenGL version information is saved in the AVEVA LFM log file on

startup which can be found in the Temp folder as shown below which reports v4.5.

The minimum needed is v4.3.

· 12: GL Major version supported: 4 115

· 13: GL Minor version supported: 5 127

Supported Cards:

NVidia GeForce/Quadro, or AMD FirePro W Series, with at least 1GB memory and

capable of supporting OpenGL version 4.3 or later.

Note:  Updated graphics drivers may be needed to meet the OpenGL

requirement.

Advanced Mode Installation3.2

AVEVA LFM Server no longer requires a dongle for AVEVA LFM NetView project

creation. To avoid unauthorised users from taking the AVEVA LFM NetView

creation license there is now an option to install an advanced version of AVEVA

LFM Server which gives access to this feature. This is illustrated in the screenshot

below.

http://www.nvidia.com/download/scan.aspx?lang=en-us
http://www.nvidia.com/download/scan.aspx?lang=en-us
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AVEVA LFM Server should be run from the Advanced Mode shortcut to be able to

create a new AVEVA LFM NetView project.

License Requirements3.3

To publish an AVEVA LFM NetView project, an AVEVA LFM NetView Creator

license is required. For more information about AVEVA LFM licenses, please

contact your AVEVA LFM Value Added Reseller or lfm.license@aveva.com.
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User Account Creation4

AVEVA LFM NetView 4.2.1 and later support both Single Sign On and AVEVA

LFM Server User authentication. If you wish to use AVEVA LFM Server User

authentication, this requires user accounts to be set up in AVEVA LFM Server to

control secure access.

Note: This is only required for projects hosted on a network or on a user's own

Cloud account. It is not required for projects hosted on AVEVA Connect.

These user accounts are created in AVEVA LFM Server and saved to the AVEVA

LFM Server project:

1. Go to File > Options > Advanced and enable Save SQL Password.

2. Switch to Options > Project and enable User control.
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3. At this point you will be prompted for the administrator password. Enter

the desired password in both boxes and click OK.

4. To set up the user accounts, go to the Utilities tab and click the Users

button. This brings up the User Management Panel:

5. To set up a new group, right-click on the Group entry and select New >

User Group.

6. Name the User Group and click OK.

7. To set the permissions for this group, click and drag the desired

permission from the Permissions section onto the appropriate group.

Repeat this for all the desired permissions.

8. After the appropriate groups have been set up, right-click on the Users

entry and select New > User.

9. To subscribe a user to a group (which allows them rights to all the

permissions within that group) click and drag the desired group from the

Groups section onto the appropriate user. Repeat this for all the desired

subscriptions.
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For AVEVA LFM NetView, the relevant permissions are:

· NetView User - Allowed to access/view the project and save

Markups/measurements to the project.

· NetView Guest User - Allowed to access/view the project and create

Markups/measurements. However, these Markups/measurements will not

be saved to the project for future use.

· NetView Go Offline - Allowed to take an AVEVA LFM NetView project

offline for on-site work, presentations, client reviews, and so on.
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Floorplan Volume Creation5

In AVEVA LFM Server the user can define the areas that are to be used for the

AVEVA LFM NetView project floorplan(s). This process replaces the need to

provide a .dxf file to act as a floorplan.

The user can either select a floorplan created from the point cloud, or add a PDF

floorplan, or use a combination of both. For instructions on adding a PDF

floorplan, please refer to the AVEVA LFM Server Home Guide.

The user should switch to the 3D orthographic view to define the floorplan(s) using

Volumes in the 3D View. For more information about volume creation in AVEVA

LFM Server, please refer to the AVEVA LFM Server Home Guide.

The volume(s) should be saved in the Volumes tab. It is common to create two

volumes, one to define the required display of the points in the floorplan, with the

second volume being used to capture all of the scan sites that should be displayed

in the floorplan. Scan sites that are not defined in this volume will not be displayed

in the floorplan.

The volumes should be saved to the Project Volumes node and provided with a

suitable name.

The following screenshot displays a sample project in the Ortho view at low

resolution.
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The following screenshot displays an example of a volume that is appropriate for

the floorplan. Note how in the left view there are scan site markers that are outside

this volume.

It is often useful to turn on Edge Mode when selecting the floorplan volume. Edge

Mode highlights areas where points are highly concentrated such as surfaces of

pipes, walls, edges of structure, and so on.

To turn on the Edge Mode, in the Visualisation tab, click the Points drop-down

menu and select the Edge Mode button:

The following screenshot displays an example of a volume that is appropriate for

the extents. Note how all scan sites are included in this volume as opposed to the

volume selected in the screenshot above.

It is often useful to turn the 3D points off when selecting the extents volume. To do

this, in the Visualisation tab at the top of the AVEVA LFM Server interface, click

Points.
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Google Maps Integration6

AVEVA LFM NetView 4.2.1 and later support the use of a Geographic Information

Systems (GIS) landing page (Google Maps). The instructions that follow will take

you through how to publish the .xml file required to enable the use of this feature.

Creating Point Measurements6.1

Using the AVEVA LFM Server Measurement tool kit, create point measurements

inside the AVEVA LFM Server dataset that correspond to the known GPS

coordinates.

Note:  A minimum of 3 point measurements with corresponding known GPS

coordinates are required to publish GIS information for AVEVA LFM NetView. The

three point measurements are required to form a triangle such that it spans the

entire dataset and covers all points within that dataset.

The following image displays the Point Measurements created in the

Measurements panel:

Note: The workflow that follows can be used only for a rough estimate of the

alignment of points, as the values obtained from Google Maps and the elevation

finder tools are not accurate. For precise positioning, it is advised to use a GPS

device while scanning a site area.
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Create a point measurement by switching to the BubbleView of a particular scan

and selecting a point to measure. To do this:

1. In the Orthographic view or in the Perspective view, right-click a given

point and select Show BubbleView. The BubbleView image of the scan

is displayed.

2. Under Tools, select Point and then click a point on the BubbleView that

you wish to measure. The x, y, z coordinates of that point are displayed

in the Point Measurement workspace.

3. Then, drag the Point Measurement from the Measurements Workspace

into the Project Measurements area to save the measurement. You may

rename the Point Measurement to a relevant name.

4. Compare the BubbleView image of the point selected to the image on

Google Maps by entering the name of the scan location in the Search

box and navigating to the specific location using Browse Street View

images.

5. After you have identified the location, note down the latitude and

longitude values.

Note: To obtain the latitude and longitude values, you could either make

a note of the values from the browser address bar or duplicate the

Google Maps tab on your browser. Then, on the duplicate tab, right-click

a point around the scan location that matches the exact location in the

BubbleView and click What's here?. The latitude and longitude values

are displayed at the bottom of the screen.

6. After you have obtained the latitude and longitude values, you can then

use these values to find the height in meters from sources such as

http://veloroutes.org/elevation/.

Note: When you have obtained the elevation for one point, you can

estimate the elevation for the second and third points by taking the

difference of the measurements. For example, consider points 1 and 2

that have z coordinates of 30.46 and 31.67, the difference being one

meter approximately. So if the elevation for point 1 is 31.2, the elevation

for point 2 can have the same value plus/minus one meter based on

whether the z coordinate is higher or lower relative to point 1. Similarly,

if point 3 has a z coordinate of 35.04, the difference thereof from the two

points is approximately 4m. It can be estimated that the elevation value

is 4m higher than the other two points.

7. After you have a point measurement, you can then create a GPS

Benchmark.

http://veloroutes.org/elevation/
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Creating GPS Benchmarks6.2

To create a GPS Benchmark:

1. Within the Benchmarks panel, right-click in the blank space and select

New > GPS Benchmark:

2. The following dialog appears. In Name, enter a name for the GPS

Benchmark. It is beneficial to give a name relevant to the point

measurement.

3. In GPS Position, enter the Latitude, Longitude and Height values

obtained from Google Maps. If AVEVA LFM Server detects that a

latitude/longitude coordinate is copied on the clipboard, it will ask you if

you want to paste these values into the dialog. Google Maps does not

give the elevation but this can be obtained from other sources such as

http://veloroutes.org/elevation/.

4. Enter the relevant LFM Position by double-clicking the point

measurement in From point to set the Benchmark to that position.

Repeat this process for all the point measurements created. For more

information, see Creating Point Measurements.

http://veloroutes.org/elevation/
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5. You should now have a minimum of 3 GPS Benchmarks in the

Benchmarks panel. Each Benchmark will also be shown in the 3D View

by a red pin object as shown below:

6. To save GPS Benchmarks, click the Point Measurements in the

Benchmark panel, and in the workspace below set GPS benchmark to

saved.

This maintains the correct position of the benchmarks when used in

another project. You can view the benchmark pins in the 3D View as

shown in the following image:
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Publishing the .xml File6.3

When you have a minimum of 3 GPS Benchmarks in the Benchmarks Manager,

you are ready to publish the GIS .xml file. If you are yet to publish your AVEVA

LFM NetView project, this will be done automatically as part of the AVEVA LFM

NetView Project Publishing process. If you are working with an already published

AVEVA LFM NetView project, you can publish the .xml file as a separate process.

To do this:

1. In the Project tab, right-click on the project node and select Publish >

AVEVA LFM NetView GIS Integration Data.

Note: You must run AVEVA LFM Server in the Advanced mode to

access the AVEVA LFM NetView GIS Integration Data feature.

2. Select the desired output folder and click Select Folder. A confirmation

dialog appears when the publish is complete and a .xml file is created at

the selected location.

3. In the .xml file that is created, you must edit the following xml tags:

· <projectLink/> - Enter the project name

· <siteLink/> - Enter the URL for the AVEVA LFM NetView landing

page

Note: In the .xml file that is generated, ensure the order of the xml tags

is <projectLink/> and <siteLink/> respectively.

For how to proceed from this point, please refer to the AVEVA LFM NetView 4.2.1

Deployment Guide.
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AVEVA LFM NetView Project Publishing7

The AVEVA LFM NetView publishing process requires access to the .zfc, .int and

(if there is colour data in the project) colour panoramic_color.jpg files.

Note:  Ensure that all the files for all datasets being published are stored in the

same folder before beginning the publishing process.

Note:  If there is demolished data in the AVEVA LFM Server datasets being

published, you must publish the HyperBubble resources. That will enable the

demolition to be reflected in the AVEVA LFM NetView project before beginning the

AVEVA LFM NetView publishing process. For guidance on how to do this, refer to

the HyperBubble and Solid Point Cloud Creation and Use Help Guide.

You can access this document by browsing to the location where AVEVA LFM

Server is installed and opening the "helpfiles" folder. By default, it is available at

this location: C:\Program Files\LFM Software\LFM\helpfiles.
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To begin the publishing process:

1. Right-click the project node and then click Publish > AVEVA LFM

NetView Project. This displays a window that enables you to select the

version of AVEVA LFM NetView you wish to publish for.

2. Click the AVEVA LFM NetView 4.2+ button. The AVEVA LFM NetView

Publisher window that is displayed enables you to enter a location where

the completed project can be published to.

3. Click Browse and select an empty folder. Then, click Next. The Cloud

upload window is displayed.

4. To publish to the Cloud, select Log in and publish to AVEVA Connect

and click Next. This should display the AVEVA Connect login page with

a list of accounts. Selecting this option publishes the project to the local

destination and also uploads the project to AVEVA Connect.

Note: To publish to a local destination, click the Local only option. After

the project is published locally, if you wish to upload the project to

AVEVA Connect, you can do so through the upload app that is available

on AVEVA Connect.
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5. On the AVEVA Connect login page that is displayed, select the

appropriate account. In the Select a Project window, from the drop-

down box, select an asset where the resources should be uploaded to

and click Select.

Note: If you are already logged in to AVEVA Connect, the system

verifies your account and displays the Select a Project window directly.

6. In the Laser Data Floorplans page, add volumes for floorplans. The

components that will make up the floorplans displayed in the AVEVA

LFM NetView project include:

· Floorplan name - The name of the floorplans as displayed in AVEVA

LFM NetView.

· Extents volume - The volume that determines which scan locations

will be displayed in that floorplan. Any scan sites outside this volume

will not be displayed in the AVEVA LFM NetView floorplan.

· Points volume - The volume that determines which points will be

displayed in that floorplan. Any points outside this volume will not be

displayed in the AVEVA LFM NetView floorplan.

For more information about volume creation in AVEVA LFM Server,

please refer to the AVEVA LFM Server Home Guide.

· View direction - The direction from which Points volume is viewed in

the AVEVA LFM NetView floorplan.

· Level of detail - Specifies the level of detail for each floorplan. For

larger floorplans, this should be set to High. For smaller projects, Low

is usually adequate.

· Floorplan style - Provides two options: Black points on a white

background and White points on a black background.
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7. To include PDF floorplans to be published to AVEVA LFM NetView, on

the PDF floorplan page, click the Add button. You can include PDF

floorplans after you have imported your PDF files through the Floorplan

tab on the Management panel and placed them to match the dataset.

Multiple PDF files can be included.

Note: 

· Each floorplan should have a unique name.

· If you wish to remove a child floorplan, you must first remove the

master floorplan. The system does not allow you to remove a child

floorplan alone.

8. Click Next to select the resources you wish to publish. These resources

include:

· Publish colour images - Generates colour AVEVA LFM NetView

BubbleViews (only available for colour scans)

· Publish intensity images - Generates intensity AVEVA LFM NetView

BubbleViews

· Publish HD images - Produces the required resources for the

magnification window in AVEVA LFM NetView

· Publish Solid Points - Generates Solid Pointcloud data

· Copy dataset files - Copies the AVEVA LFM Server dataset (.lfd)

into the publish location. This is most useful for cloud hosted projects.

For locally hosted projects, a copy of the AVEVA LFM Server dataset

is likely to be available.

· Mask demolished areas - Masks any demolished points from the

AVEVA LFM Server project as black in the AVEVA LFM NetView

BubbleViews.

9. On the Project options page, if you have an object file that you want to

process, enter the required information for the following fields:

· Working units - Default working units for the AVEVA LFM NetView

project.
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· Object processing - Enable to include the specified objects file in the

AVEVA LFM NetView project.

· Object file - Browse to the location of the objects (.zgl) file.

· Object cache generator - Navigate to the AVEVA LFM NetView

Object Cache Generator folder where AVEVA LFM Server is installed

(by default C:\Program Files\LFM Software\LFM NetView Object

Cache Generator).

· Object inclusion - You can select one from HIGH, MEDIUM and

LOW. For example, when set to HIGH, assuming you are looking at

the object from the position of a scan site, you can see at least 10

pixels belonging to the object. So, it is considered visible and added to

the visibility list. Similarly, it is 20 pixels for MEDIUM and 30 pixels for

LOW.

· Select BubbleViews to process objects - Select the BubbleViews

against which the object file should be processed. It is usual for all the

BubbleViews to be selected.

10. Click Next. The LFM NetView service server settings page is

displayed with the following fields:

· Make password file - Enable to generate a password file for the

users and permissions in the current project. This will also be used to

create users for the AVEVA LFM NetView project and check their

AVEVA LFM NetView related permissions.

· Offline session time limit - Use the arrow buttons to specify the

number of days an offline AVEVA LFM NetView session will remain

valid for. This ensures that the users accessing an offline AVEVA LFM

NetView session keep their data up to date.
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11. Click Publish to start the publishing process. The Publishing window is

displayed that shows the progress for each step in the process. On

successful completion, a message is displayed.
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AVEVA NET Project Publishing8

You can integrate your AVEVA LFM project into AVEVA NET by publishing your

project using AVEVA LFM Server.

Before you begin publishing to AVEVA NET, ensure that you have:

· A license containing the 'Hotspot' license feature

· User Control enabled in File > Options > Project.

Note: To export to AVEVA NET using an object file, ensure that the object file is

loaded by right-clicking the .zgl file and selecting Show.

To begin the publishing process: 

1. Right-click on the project node and select Publish > AVEVA NET

Project. The following dialog appears:



Page 29 Release 5.3

© Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.

 

CHAPTER 8 - AVEVA NET Project Publishing

LFM NetView Project Publishing Guide

2. In Project URL, enter the project URL for your AVEVA LFM NetView

project. For example, http://machinename/LFM

NetView/Project/project.proj.

Note: You must know your project URL and project context before

performing the export. If you do not, enter DummyURL and

DummyContext respectively. You must then replace these strings with

the actual project URL and context in the XML files that are produced.

See Publishing the .xml File.

3. In Project Context, enter the AVEVA NET context and then click Next.

The Item Selection page is displayed, where you can select the objects

or 3D markups to be exported to AVEVA NET.

4. You may use the following options to select, although the Move all to

included list option is often used:

·  Move selected to included list

·  Move all to included list

· Move all to not included list

· Move selected to not included list

5. After you have moved the items to be exported, click Finish. You will

then be directed to select a folder where you want your published files to

be stored.

6. Navigate to the location you want to export to and click Select Folder.

The export process begins, represented by the progress bar at the

bottom of the AVEVA LFM Server interface.

After the process has completed, the exported AVEVA NET XML files

are produced at the selected location. The resultant files can then be

imported into AVEVA NET through the AVEVA NET Import Controller.
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The XML files that are produced as part of publishing to AVEVA NET are shown in

the following image:

· 01_ExtraClasses_null.xml - Contains a classification of different objects

· AssociationsPermissibles_null.xml - Provides a hierarchy for objects

inside AVEVA NET

· NetViewProject_Eaton_TLP_null.xml - Contains information about all

the objects in the export.

Note: This file contains the Project authentication user, which includes the

strings DummyURL and DummyContext that should be replaced.

Alternatively, you can publish an AVEVA NET project using 3D markup objects. To

use this method, ensure the AVEVA LFM Server dataset is loaded with the

Pointcloud displayed, and then add the 3D markup objects. The rest of the

procedure is as outlined above.
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The workflow for exporting to AVEVA NET is shown below:
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VHD Creation (Cloud deployment only)9

For small AVEVA LFM NetView projects (less than 100 scans) it is possible to

copy the project from the local AVEVA LFM NetView Publishing machine to a

Virtual Hard Drive (VHD) that is created at the hosting centre. However, for large

projects, it is required that the VHD is created locally and shipped to the

appropriate hosting centre. This document deals with the latter scenario.

In all cases a VHD should be used to hold the AVEVA LFM NetView project data.

Creating the VHD (Windows 7)9.1

If there is not enough space on the local PC, it is possible to create a VHD on a

network drive and attach it to the local PC as if it were a local disk.

This process creates virtual disks in the .VHD format where the minimum size is

3MB.

To begin:

1. Right-click on My Computer and select Manage.

2. Alternatively, you can type diskmgmt.msc into the Windows Start search

box and press Enter.
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3. The Computer Management screen opens. Select Disk Management >

Action > Create VHD.

4. Browse to the directory where you want the disk to reside, select the

size you want it to be (based on the estimation given at the beginning of

the AVEVA LFM NetView publishing process), and select dynamic or

fixed.

5. If you want the disk to expand in size as you add files to it, then select

Dynamically expanding. Otherwise, if you want a consistent specific

size, select Fixed size.

Note:  AVEVA LFM recommends selecting Fixed size. Click OK to

begin the VHD creation process.

6. The VHD will now be created. You can track the progress by observing

the status bar at the bottom of the interface.

Note: Creating large VHDs on network drives can take a few hours to

complete. As a guide a 500GB VHD will take about 1.5 hours to create.
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7. After it is complete, you will see the virtual drive listed in Disk

Management as unallocated space.

8. To begin using the VHD you will need to right-click on the disk and

select Initialize Disk.

9. In the Initialize Disk box, select MBR (Master Boot Record) and click

OK.
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Create a Volume9.2

To create a volume:

1. Right-click the unallocated space and select New Simple Volume. The

wizard shown below appears.

2. Click Next.
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3. Select the amount of space you want to use for the volume. For

example, the maximum disk space is 511 GB, make the simple volume

size 485 GB.

4. Assign the volume a drive letter that is not currently being used.

5. Format the new volume as NTFS. Enable the relevant boxes if you want

a quick format and file compression.



Page 37 Release 5.3

© Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.

 

CHAPTER 9 - VHD Creation (Cloud deployment only)

LFM NetView Project Publishing Guide

6. The wizard is complete, click Finish.

If you have AutoPlay enabled, Windows displays the pop-up shown below for you

to open up your new virtual hard disk.

The disk will be listed in the Windows Disk Management utility. It will also be

listed on My Computer.

For further assistance, you may contact your local AVEVA LFM Value Added

Reseller (VAR). To find your local AVEVA LFM VAR, please visit http://web.lfm-

software.com/en/Value-Added-Resellers.aspx. If there is no AVEVA LFM VAR in

your area, please contact lfm.support@aveva.com.

http://web.lfm-software.com/en/Value-Added-Resellers.aspx
http://web.lfm-software.com/en/Value-Added-Resellers.aspx
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